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TOPIC  EXPERIMENT  NAME PG.NO 

MS-WORD 1 CREATING A VISITING CARD IN MS-WORD 1 

2 CREATING A LETTER IN MS-WORD 4 

3 CREATING A MAIL MERGE  7 

MS-EXCEL 4 CREATING A CHART FROM SPREAD SHEET 

DATA 

13 

5 EVALUATING THE GRADE OF STUDENTS IN 

EXCEL 

19 

MS-POWER POINT 6 CREATING A POERPOINT PRESENTATION 24 
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Experiment -1 

Creating a Visiting Card using MS-Word 

Aim: To Create a Visiting Card of your college using page size as follows 

 Page width= 3.2 inches 

 Page height=2.2 inches and use different font styles, sizes, alignments.  

 

Procedure: 

Step 1: Open MS-Word by click on start button; go to “all Programs”, then select 

Microsoft Office Word 2007. 

Step 2: To open a new document, Click on Office Button then select  

New - > Blank Document then click on create option. 

Step 3: Now click on “Page Layout” from the Menu bar. Then click on Margins then 

click on Custom Margins option. Then the “Page Setup” dialog box appears; in this you 

find three tabs namely “Margins”, ”Paper”, ”Layout”. Then in the ‘Margins’ tab, make all 

the parameters like Top, Bottom, Left, Right, and Gutter to zero and make Gutter 

Position to Left. Then in the Page tab, change the width and height options to 3.2 inches 

and 2 inches respectively. Then in the Layout tab, make the Header and Footer to zero. 

Now this page is set to the visiting card as follows. 
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Step 4: In this step we have to enter the telephone number and Fax number on the top 

part of the paper. It can be done as follows: 

 First go to insert menu, then select Symbol option. 

 Then change Font to “Wingdings”. 

 
 Then select the appropriate to your need i.e., to the telephone option select, 

and to the Fax option . 

Step 5: Now write  your institution name and make it to the center alignment . 
 

Step 6: Now write all the details you want to put in your visiting card as your needs. And 

select the text and make it to . 

Step 7: Now change the background color by selecting Page color option from Page 

Layout menu. 

Step 8: This is the final step in creating Visiting Card. In this step, we have to save the 

letter as “Visiting Card.docx” by selecting “Save” option from Office button. Then a 

prompt window will ask you to write a file name. Now you have to give the file name 

and press the save button. 
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Output: 

 

****************************************************************************** 
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Experiment - 2 

Creating a Leave Letter in MS-Word 

Aim:To Write a leave letter to the Principal by using different alignments, correct 

formats in MS Word. 

Procedure: 

Step 1: Open MS-Word by click on Start button; go to All Programs, then select 

Microsoft Office Word 2007. 

Step 2: To open a new document, Click on Office Button then select  

New - > Blank Document then click on create option. 

Step 3: Then select text area, and then write Leave Letter as a heading, Select the text, 

click on bold button to make it bold as “Leave Letter”, and change the font size to 16. 

Step 4: Then write date and place in a format as 

follows  

date: 19/10/2012, 

Visakhapatnam. 

Then Select the text and make it right by clicking on right alignment button  

 

Step 5: Then write To address as follows and select this text and make it left by clicking on 

left alignment button   

To 

The Principal, 

Mrs AVN College, i-

Town, 
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Visakhapatnam. 

Step 6: Then write Subject according to your letter. And select this text and press tab 

button for two times. 

Step 7: Then write the body of the letter according to your letter. And select this text and 

make it 

justification by clicking on justify alignment button  

Step 8: Then write “Thanking you Sir,” select this text and make it to center by clicking on 

center alignment button  

Step 9: Now write the “From address” as follows  

Yours Faithfully, 

T.Sirisha 

Then make it right by clicking on Right alignment button  

Step 10: This is the final step in writing leave letter. In this step, we have to save the 

letter as “leave letter.docx” by selecting “Save” option from Office button. Then a 

prompt window will ask you to write a file name. Now you have to give the file name 

and press the save button. 
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Output 

 

To 

The Principal, 

Mrs AVN College Polytechnic,  

I-Town, 

Visakhapatnam. 

 

Sub: Requesting for 5 days leave-Reg Respected Sir, 

 

I T.Shirisha bearing roll number 12331-CM-001 studying Diploma I year in CME 

department in your college. As I  am going to my home on the occasion of Ugadi festival and 

also to celebrate my birthday on the next day.So I kindly request you to grant me leave for 5 

days i.e.,24/3/2012 to 28/3/2012. 

Thanking You Sir, 

Yours Faithfully, T.Sirisha, 

DCME,I year. 

 

Date:15/10/2015, 

Visakhapatnam. 
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Experiment -3 

Creating a Mail Merge Letter in MS Word 

 
  Aim: To create a mail merge letter in MS-word 

To get started: 

 Click on the Mailings tab, then the Start Mail Merge button, and then Step by Step 

Mail Merge Wizard… 

 

 

 

 

 

 

 

 The wizard will open in the task pane to the right. Select your document type. 

To create the letters 

Step 1: Select Document Type 

1. Select Letters from the Mail Merge task pane and click on next to start the document. 

2. Click Next: Starting document 
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Step 2: Starting Document 

1. Click Use the Current Document under Select starting document 

2. Click Next: Select recipients  

Step 3: Select reciepents 

The recipients can come from either an existing Excel file, or Access table or you can 

create a new list. 

If Using an Existing List: 

1. Click Use an existing list under Select recipients 

2. Click Browse 

3. Select the file 

4. Click Open Mail Merge Recipients opens showing the names and addresses 

from your file 

5. Click OK 
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Click Next: Write your letter To Type a New List: 
 Click Type a new list under Select recipients 

 2) Click Create 

 Click Customize Columns to modify the list of fields 
 

 

 Delete any unnecessary field names and/or add new ones 

 Click OK 

 Type records here hitting TAB to advance to the next field and to continue 

adding new records 
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 Click OK 

 Click Save 

The recipients list will be saved as a separate file as a Microsoft Access file type. It is 

saved in the My Data Sources folder. It is recommended to save the file in this folder. 

 

 Click Next: Write your letter Step 4: Write your letter 

1) Click the location in your document where the data from the mail 

merge fields need to be inserted 

2) Insert the fields using Insert Merge Field from Mailings tab. 

The field name will look like this: <<Name>> 

3) Repeat this step until all fields have been inserted. Remember to put 

spaces and punctuation where needed. 

4) Click Next: Preview your letters 

Step 5: Preview your letters 

 Here is where you can preview the first page with the fields filled in. 

 Click Next: Complete the merge 

Step 6: Complete the merge To Complete the Merge: 

 Click Print to send directly to the printer 

 Click Edit individual letters to create a new file 
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 Output: 

D:20/05/2012 

Karimnagar. 

 

 
To,  

Gopinath,  

10-22, 

 James Street, Kurnool, 

Vizianagaram. 

Dear Gopinath, 

Hai! How are you? Am fine here. How are your studies going on? What about the mid exams. Am happy to say 

that our college has conducted freshers party for us in the  last week at our college premises.Many competitions such as sports, food 

competition and funny games were conducted before the Fresher’s Day. We enjoyed a lot up to the last second of the party and our 

college has provided food and transportation facility also. Ok bye and “all the best” for your exams. 

Yours Lovingly,  

A.Ravi kum ar. 

 
 

 

 

 

 
To, Shiva, 

15-16, 

Geetha Bhavan, 

Karimnagar, 

Karimnagar. 

Dear Shiva, 

D:20/05/2012 

Karimnagar. 

Hai! How are you? Am fine here. How are your studies going on? What about the mid exams. Am happy to say 

that our college has conducted freshers party for us in the  last week at our college premises. Many competitions such as sports, food 

competition and funny games were conducted before the Fresher’s Day. We enjoyed a lot up to the last second of the party and our 

college has provided food and transportation facility also. Ok bye and “all the best” for your exams. 

Yours Lovingly, 

A.Ravi Kumar.  
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D:20/05/2012 

 

karimnagar. 

To, 

Shilpa, 

12-10, 

Thimmapur,  

East Godavari district, 

 

Dear Shilpa, 

Hai! How are you? Am fine here. How are your studies going on? What about the  mid exams. Am happy to say 

that our college has conducted freshers party for us in the last week at our college premises.Many competitions such as sports, food 

competition and funny games were conducted before the Fresher’s Day. We enjoyed a lot up to the last second of the party and our 

college has provided food and transportation facility also. Ok bye and “all the best” for your exams. 

Yours lovingly, 

A.Ravi Kumar 

 

****************************************************************************** 
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Experiment -4 

Creating a Chart from a spreadsheet data 
Aim:. To Create an electronic spread sheet which shows the sales of different products 

for 5 years. Create column chart for the following data  

Year Product_1 Product_2 Product_3 Product_4 

2010 1000 800 900 1000 

2011 800 80 500 900 

2012 1200 190 400 800 

2013 400 200 300 1000 

2014 1800 400 400 1200 

 
Creating the spread with different products of 5 year 

Before you can make a chart, you must first enter data into a worksheet. To 

create the spread sheet with 5 years different products follow the below steps 

Step1: 

Click on the cell B1 and type “Product_1” and go to the next cell by clicking the 

Tab key on the keyboard. 

Step 2: 

In the cell C1 type “Product_2” and click on tab key to activate next cell. Repeat 

the  above to steps to enter “Product_3”, “Product_4” 
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Step3:  

Click on cell “A2” and type “2010” then press on tab key to activate the next cell. 

 

Step 4: 

Repeat the above procedure to enter the details of four products for five years. Finally we have 

the data of products as follows
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Creating a Column chart for the above Data Definition of Chart: 

Charts allow you to present data entered into the worksheet in a visual format 

using a variety of graph types. 

Following steps are given to draw a Chart 

 

 Enter data in the work sheet: Suppose you entered data as given in below 

 

 Now select data range: By using the mouse high light the range of data you want to take 

 

 

 Click Insert Tab and select a chart type from the chart group  
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 and Select the sub type of chart ( In this example selected a 2D Column chart) 

 The Chart will be displayed as follows 

 

1. Select the Title of the chart 

 To give a title to a chart, click on the chart. Now you can see layout 

tab available. Click on Layout tab. 

 Choose(click) on chart title option available in the Label group 

 Click on the chart title and write a title “Product Analysis”. 
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2. Give a name to X-Axis 

 Click on Layout tab. 

 Then select Axis Titles from Labels Group. 

 Select Primary Horizontal Axis Title, as shown below. 

 Now, click on the Axis Title and write an X-axis title “Year”. 

 Follow the same steps to give a title to Y-axis “Product Sales”. 

 

 

 

 

3. Adding Data Labels to the chart 

 Click on Layout tab. 

 Then click on Data Label option available in Labels Group. 
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 Now choose a format to display data labels 

 

 

Output: 

 

 

****************************************************************************** 
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Experiment -5 

Evaluating the grade of a Student 

 
Aim :  To Create a suitable examination data base and find the sum of the marks(total) of 

each Student and respective class secured by the student 

Rules 

 Pass if marks in each subject > = 35, 

 Distinction if average>=70, 

 First class if average>=60 but <70, 

 Second class if average >=50 but <60, 

 Third class if average>=35 and but <50 , 

 Fail if marks in any subject is <35 . 

  

Display average marks of the class, subject wise and pass percentage 

Solution: 

To find the grade of a student we need to follow the following steps 

 

Step 1: Typing Student database in Excel 2007 

 

Type the student database with the required fields starts from A1 cell as follows 
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Step 2: To find Total Marks of Student 

 

To find the total marks of a student click on the cell “G2” and type the following 

formula 

 

To find the total marks for the remaining students select “G2” cell and drag down to 

the remaining students. 

 

 

Step 3: To find Average marks 

 

To find the average marks of the student click on the cell “H2” and type the 

following formula 



 
23 

 

To find the average marks for the remaining students select “H2” cell and drag 

down  to the all the students. 

 

 

Step4: To Check Pass or Fail 

 

To check whether the student is Pass or Fail select the cell “I2” and type the 

following formula 

 

To check the remaining students are Pass/Fail select the cell “I2” and drag down to all 

the students 
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Step 5: To find Grade 

 

To find the grade of a student click on the cell “J2” and type the following formula 

 

 

 

To find the grade for the remaining students select “J2” cell and drag down to the 

all the students 

 

 

Finally we get the following student database with total, average and grade 
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Output: 

 

 

****************************************************************************** 
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Experiment -6 

Creating Power Point Presentation for First year Subjects 

Aim: Make a Power point presentation of all the details of the books that you had studied 

in B.Sc. First Year. 

PowerPoint is presentation software that can be used to create slide shows for 

printing, on-screen projection, or Web-based display. 

Opening PowerPoint 

Note: The procedure for opening PowerPoint may vary depending on the setup of your 

computer. 

To open PowerPoint in Windows, click on the 

Start button --> Programs --> Microsoft PowerPoint 

When PowerPoint 2007 is opened, a blank Title slide appears by default as the first slide 

in your new presentation. You can start a new presentation when you first open 

PowerPoint or after PowerPoint is already open. 

To change the layout of an open slide, click on the Layout button in the Home tab. 

 

From the Home tab in the Slides group, click on New Slide. A blank slide will 

be inserted after your active slide. 

If  you wish  to  choose the layout  while creating  your new slide, click on the 

New Slide button and choose a theme.  
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Select the new slide from Quick menu option or Ribbon Option: 

 

Apply a new layout to a slide 

To change the layout of an existing slide, do the following: 

1. On the Slides tab, click the slide that you want to apply a new layout to. 

2. On the Home tab, in the Slides group, click Layout, and then click the new 

layout that you want. 

Copy a slide 

To copy a slide does the following 

1. On the Slides tab, right-click the slide that you want to copy, and then click 

Copy on the shortcut menu. 

2. Still on the Slides tab, right-click where you want to add the new copy of the 

slide, and then click Paste on the shortcut menu. 

You can also insert a copy of a slide from one presentation into another presentation. 

Rearrange the order of slides 

 

 On the Slides tab, click the slide that you want to move, and then drag it to the 
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location that you want. 

To select multiple slides, click a slide that you want to move, and then press and 

hold CTRL while you click each of the other slides that you want to move. 

Delete a slide 

 On the Slides tab, right-click the slide that you want to delete, and then click 

Delete Slide on the shortcut menu. 

Adding text to a slide 

The Title Slide layout contains text boxes for a title and a subtitle. Try typing text into 

these boxes. 

1. Click in the Title text box. A dashed line border with a circle in each corner and a 

square box at each midpoint appears around the text box indicating that it is 

selected. 

Adding list of subjects that studying in B.Sc. First Year into the slides: 

 

2. Click the Subtitle text box and type a subtitle. 
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Selecting a Theme or Designing Slides 

Design themes are a convenient way to add a professional flair to your 

presentation. Themes include preset colors, fonts, backgrounds, and formatting effects. 

PowerPoint provides you with the option to customize one of their existing themes. 

Selecting a Theme 

To choose a Theme for an open slide, use the Theme group under the Design tab. 

Use  the arrows on the right of the Theme group to scroll through the themes, or to see 

all available themes at once. When you hold your mouse over any of the examples, 

PowerPoint will show you a preview of the slide. 

 
Animating Text and Images Adding Animation to Slides 

1. Click on the object or text box you wish to animate (hold down the Ctrl button 

while clicking to select more than one). 

2. In   the Animations   tab under   the Animations   group,    select    an    option    

from  the Animate pull-down list. As you move your mouse over each choice 

PowerPoint will preview the effect  
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on your slide.  

3. Repeat for any other slides or objects you wish to animate. 

Run Your PowerPoint Slide Show 

After you create your slides, you can run your slide show: 

 Press F5. 

 Choose the Slide Show tab. Click the From Beginning button  in the 

Start Slide Show group. 

 Click the Slide Show icon in the bottom-right corner of your screen. 

Saving your presentation 

If  you   are  saving  a  document  for  the  first  time,   you  will  need  to  use  

the Save   As command;   however,   if   you   have    already    saved    a    presentation,    

you    can    use the Save command. 

To use the Save As command: 

 Click the Microsoft Office button. 

 Select Save As. Now a menu will appear. 

 Select the type of file you want to save the presentation as 

 Enter a name for the document. 

 Click the Save 

button. To use the Save 

command: 

 Click the Microsoft Office button. 

 Select Save from the menu. 

Using the Save command saves the document in its current location using the same file name. 

****************************************************************************** 


